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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the 

products supplied by Meggitt SA (Meggitt Sensing Systems) are based on information believed to be 

reliable, but unless otherwise expressly agreed in writing with Meggitt SA the accuracy or 

completeness of such data is not guaranteed. Before using this product, you must evaluate it and 

determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, 

user manuals, service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability 

associated with use of the product. Meggitt SA takes no responsibility for any statements related to the 

product which are not contained in a current English language Meggitt SA (Meggitt Sensing Systems) 

publication, nor for any statements contained in extracts, summaries, translations or any other 

documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for 

new products purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 
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PREFACE 

 

About these release notes 

This document provides important information about the VibroSight 
®
 software from Meggitt Sensing 

Systems. It is applicable to all VibroSight-based condition monitoring systems using the versions of 

software described by this document, namely: 

 VibroSight software version 3.3.0 (CD part number 609-004-000-040). 

This document contains information about changes to the software since the previously released 

version (VibroSight 3.2.0), such as new features and improvements, solved problems and bug fixes, 

and hardware and software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), 

refer to the following Meggitt Sensing Systems (MSS) documentation: 

 VibroSight software data sheet 

        (MSS document ref. 660-020-005-218A) 

 Getting started with VibroSight installation guide 

        (MSS document ref. 660-010-006-219A) 

 VibroSight help 

 XMV16 / XIO16T extended vibration monitoring card pair data sheet 

        (MSS document ref. 660-020-010-208A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in 

earlier versions of the software: 

 VibroSight 2.9.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.1 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.2 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.4 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.5 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.6 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.7 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.1 (MSS document ref. 660-010-013-201A) 

 VibroSight 2.11.0 (MSS document ref. 660-010-013-203A) 

 VibroSight 2.11.1 (MSS document ref. 660-010-013-204A) 

 VibroSight 2.11.2 (MSS document ref. 660-010-013-205A) 
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 VibroSight 2.11.3 (MSS document ref. 660-010-013-206A) 

 VibroSight 2.11.4 (MSS document ref. 660-010-013-207A) 

 VibroSight 2.11.5 (MSS document ref. 660-010-013-208A) 

 VibroSight 2.11.6 (MSS document ref. 660-010-013-209A) 

 VibroSight 2.12.0 (MSS document ref. 660-010-013-210A) 

 VibroSight 2.12.1 (MSS document ref. 660-010-013-211A) 

 VibroSight 2.12.2 (MSS document ref. 660-010-013-212A) 

 VibroSight 2.12.3 (MSS document ref. 660-010-013-213A) 

 VibroSight 2.12.4 (MSS document ref. 660-010-013-214A) 

 VibroSight 2.12.5 (MSS document ref. 660-010-013-215A) 

 VibroSight 2.12.6 (MSS document ref. 660-010-013-216A) 

 VibroSight 2.12.7 (MSS document ref. 660-010-013-217A) 

 VibroSight 3.0.0 (MSS document ref. 660-010-013-218A) 

 VibroSight 3.1.0 (MSS document ref. 660-010-013-219A) 

 VibroSight 3.2.0 (MSS document ref. 660-010-013-220A). 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the 

software modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic, 

 Scope,  Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future 

reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following 

information: 

 Major release identifier: x.x.x.x 

 Minor release identifier: x.x.x.x 

 Update release identifier: x.x.x.x 

 Maintenance (build) release identifier: x.x.x.x 

For each scheduled release of VibroSight, at least one of the first three digits changes (x.x.x.x). 

For unscheduled releases, that are occasionally required to solve urgent problems, only the fourth 

digit changes (x.x.x.x). 
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The version identifiers for installed software appear in the Help About box (obtained using 

Help > About … in any VibroSight software module). 

 

Terminology 

To distinguish between the different Meggitt Sensing System products that can be used with the 

VibroSight software, the following terminology is used in this document: 

 VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 

rack. The currently available VM600 cards that are designed for operation with the VibroSight 

software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T) and the new CPUR/IOCR card pair. 

Where CPUx card is used in this document, it refers to CPUM and CPUR cards, and where 

IOCx card is used in this document, it refers to IOCN and IOCR cards, unless otherwise stated. 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T cards, unless otherwise stated. 

 VibroSmart module or VibroSmart device – to refer to VibroSight-software compatible modules 

or devices that are used in a distributed monitoring system. The currently available VibroSmart 

modules and devices that are designed for operation with the VibroSight software are the 

VSI010, VSN010 and VSV300. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV300 

modules, unless otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to 

the VSI010 and VSV300 modules and the VSN010 device, unless otherwise stated. 
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1 Licensing 

In general, the licence required to enable purchased product options remains unchanged between 

update and/or maintenance level releases, for example, from version 3.2.0 to version 3.3.0. 

However, a new licence is always required for upgrades between major level releases, for example, 

from version 2.x.x to version 3.x.x. 

NOTE: VibroSight 3.3.0 is a minor level release and a new licence key file is not required 

for upgrades from VibroSight 3.2.0. 

However, a new licence key file is required for upgrades from VibroSight 2.x.x. 

 

To obtain a new VibroSight licence key file or for further information on licence keys, contact Meggitt 

Sensing Systems customer support. See 7 Customer support. 

 

 

2 Features 

General 

2.1 Support for integrated data management 

The VibroSight software has been improved to include integrated support for data management that 

simplifies the configuration and operation of a data management strategy for a VibroSight-based 

machinery monitoring and protection system. 

To use VibroSight’s integrated data management to implement a data management strategy: 

 VibroSight Configurator is used to configure the integrated data management operations that 

are required to be run on the VibroSight data repository used by the system. 

That is, the Offline data storage, Data purge and Database backup operations. 

 VibroSight Server automatically calculates, schedules and runs individual commands on the 

server’s data repository to implement the required data management strategy (corresponding 

to the operations configured in VibroSight Configurator). VibroSight Server also reports the 

status of the individual commands on a dedicated Data management tab, making it easier to 

know the state of the data management for a system. 

VibroSight’s integrated data management is completely self-contained: there is no longer any 

requirement for a separate task scheduler such as Windows Task Scheduler to help automate data 

management for a system. 

 

As shown in Table 1, VibroSight’s integrated data management operations are approximately 

equivalent to the data repositories commands that exist in VibroSight System Manager. 
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Table 1: A comparison of VibroSight’s integrated data management operations 
and data repositories commands 

VibroSight 

Integrated data management operations 
 

Configured in VibroSight Configurator 
and run automatically by VibroSight Server 

Data repository commands 
 

Run manually in VibroSight System Manager 
or run automatically by a task scheduler 

Offline data storage Copy 

Data purge Purge 

Database backup --- See note 1 

--- See note 2 Summary 

--- See note 3  Database update 

 

1. There is no Data repository backup command in VibroSight System Manager as it is not required. 

    A VibroSight data repository (VibroSight historical data folder (*.vshdf) and the associated Storage subfolder) is backed  

    up using the Copy and Paste commands in a Windows Explorer. 
 

2. There is no Summary operation in VibroSight Configurator as it is not useful (as a scheduled task). 
    The Summary command in VibroSight System Manager can be run as an unscheduled task. Alternatively, the Offline data  
    storage operation in VibroSight Configurator has a “Create summary file” option that can be used to provide similar  
    information. 
 

3. There is no Database update operation in VibroSight Configurator as it is not required. 

    A VibroSight data repository (VibroSight historical data folder (*.vshdf) and the associated Storage subfolder) is  

    automatically updated by VibroSight as required. 

 

It is important to note that the Data repositories commands that exist in VibroSight System Manager 

will continue to be supported as System Manager commands. However, the command-line equivalent 

of these commands are no longer supported, as for the purposes of data management strategy they 

are effectively replaced by VibroSight’s integrated data management operations. 

NOTE: Starting with VibroSight 3.3.0 the command-line equivalent of the Data repositories 

commands that exist in VibroSight System Manager are no longer supported, that 

is: vibrosightdatacopy.exe (Copy), vibrosightdatapurge.exe (Purge) 

and vibrosightextractsummary.exe (Summary). 

 

NOTE: Because of the changes to the VibroSight System Manager Data repositories 

commands, any existing data management and system backup procedures for a 

VibroSight-based machinery monitoring and protection system must be manually 

migrated to use VibroSight’s integrated data management operations in order to 

ensure that the data management continues to work. 

Typically, such VibroSight data management procedures include batch files using 

the vibrosightdatacopy.exe and/or vibrosightdatapurge.exe 

command-line commands that are run by Windows Task Scheduler. 

 

See also 2.9 Data repositories commands. 
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2.1.1 Recommended data management strategy using VibroSight’s integrated 
data management 

Now that the VibroSight software includes integrated support for data management, the recommended 

data management strategy for a VibroSight-based machinery monitoring and protection system 

consists of three steps, as follows: 

 

1. Daily backups of the data repository used by the VibroSight Server – configured using the 

Database backup operation. 

Online VibroSight historical data folder (*.vshdf)  

offline VibroSight historical data folder (*.vshdf). 

Backups are required in order to always have an up-to-date offline copy of the data repository that can 

be reverted to in case of a problem with the online data repository. Daily backups help reduce the risk 

of data loss and system downtime. A daily backup is recommended as it is a good compromise 

between operating performance of the machinery monitoring system and data loss. 

NOTE: It is good practice to store onsite backups on different storage devices. For 

example, different hard disks or hard drives, preferably on different storage devices 

or computers. 

It is good also practice to have offsite backups in order to help prevent data loss. 

 

2. Weekly or monthly copies of the data repository used by the VibroSight Server – configured using 

the Offline data storage operation. 

Online VibroSight historical data folder (*.vshdf)  

multiple smaller offline VibroSight historical data archives (*.vshda). 

Regular copies (offline data storage) are required in order to build up an offline historical record of the 

latest data from the data repository that can be referred to when analysing/diagnosing machinery. (In 

order to limit the size of the online data repository, offline data storage is used to copy older data 

before it is purged from the data repository.) Weekly or monthly copies are recommended as they are 

a good compromise between operating performance of the machinery monitoring system and file/data 

handling (VibroSight historical data archive file sizes). 

 

3. After the data has been copied to offline data storage (step 2 above), regular purges of the data 

repository used by the VibroSight Server  – configured using the Data purge operation. 

Online VibroSight historical data folder (*.vshdf)  

made smaller (*.vshdf). 

Regular purges are required in order to limit the size of the online data repository so that it does not 

become too large, which can lead to problems with operating performance of the machinery 

monitoring system and file/data handling issues. Once configured, repeated purges of the online 

VibroSight historical data folder are automatically run by the VibroSight Server in order to restrict the 

size of the data repository. 
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NOTE: VibroSight’s integrated data management means that VibroSight Server 

automatically calculates, schedules and runs individual commands corresponding 

to the Data management operations configured in VibroSight Configurator, in order 

to automate the data management strategy. 

 

Note: The times/timescales used in the steps of the Recommended data management strategy using 

VibroSight’s integrated data management commands example above are for a typical VibroSight-

based machinery monitoring and protection system and for illustration only. The times/timescales used 

in a particular system depend on many factors, such as the density/volume measurement data and/or 

the importance of the data, and should be configured accordingly. 

 

See also 2.5 Configuring integrated data management and 2.7 Running integrated data management. 

 

 

2.2 Interprocess communication – WCF replaces .Net Remoting 

The VibroSight software has been improved to replace the use of .Net Remoting with WCF (Windows 

Communication Foundation) for all interprocess communication required by the underlying client-

server architecture of VibroSight. For example, this includes communication between a VibroSight 

Server and clients such as VibroSight Vision and VibroSight Mimic, and communication between 

VibroSight and other servers such as a VibroSight Modbus Server or a VibroSight OPC Server. 

WCF has been used to replace .Net Remoting in order to: 

 Improve performance, reliability and security. 

 Increase interoperability and extensibility. 

(VibroSight System Manager continues to use .Net Remoting for some interprocess communication 

but is planned to be completely migrated to WCF for the next release of VibroSight.) 

Note: .Net Remoting has effectively become a “legacy” product that is supported by Microsoft for 

reasons of backward compatibility only. 

 

 

2.3 Unit preferences – new physical quantities and units 

To improve support for combustion monitoring applications, the default Metric and Imperial unit sets 

included in VibroSight have been updated to include the additional physical quantities and units listed 

in Table 2. 

To view the unit preferences, click Tools > Unit Preferences on the menu bar in a VibroSight 

software module, such as VibroSight Configurator, VibroSight Scope or VibroSight Vision. 
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Table 2: New physical quantities and units in VibroSight 3.3.0 

Physical quantity 
Unit Unit set 

Symbol Name Metric Imperial 

Acidity pH Potential of hydrogen Default Default 

Density kg/cm
3
 kilogram per cubic centimetre Available Available 

Density mg/m
3
 milligram per cubic metre Available Available 

Density mg/Sm
3
 milligram per standard cubic metre Available Available 

Frequency mHz millihertz Available Available 

Fuel consumption Sm
3
/kWh standard cubic meter per kilowatt hour Default Unavailable 

Lower calorific value kJ/kg kilojoule per kilogram Default Default 

Gradient ratio %/min percentage per minute Default Default 

Head m head Default Available 

Head ft head Available Default 

Heat of combustion J/kgK joule per kilogram-kelvin Default Default 

Heat value by mass J/kg joule per kilogram Available Available 

Heat value by volume kcal/Nm
3
 kilocalories per normal cubic meter Available Available 

Higher calorific value kJ/kg kilojoule per kilogram Default Default 

Mass kg kilogram Default Unavailable 

Mass g gram Available Unavailable 

Mass mg milligram Available Unavailable 

Mass µg microgram Available Unavailable 

Mass t metric tonne Available Unavailable 

Mass oz ounce Unavailable Available 

Mass lb pound Unavailable Default 

Pressure MPa megapascal Available Unavailable 

Ratio ppb parts per billion Available Available 

Turbidity g/L grams per litre Default Default 

Volume Nm
3
 normal cubic meter Available Unavailable 

Volume concentration % v/v volume / volume percentage Available Available 

Volumetric flow rate l/min litre per minute Available Unavailable 

Volumetric flow rate l/h litre per hour Available Unavailable 

Volumetric flow rate Nm
3
/d normal cubic metre per day Available Unavailable 
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Physical quantity 
Unit Unit set 

Symbol Name Metric Imperial 

Weight kg kilogram Default Unavailable 

Weight g gram Available Unavailable 

Weight mg milligram Available Unavailable 

Weight µg microgram Available Unavailable 

Weight t metric tonne Available Unavailable 

Weight oz ounce Unavailable Available 

Weight lb pound Unavailable Default 

Weight ratio % percentage Default Default 

 

 

2.4 Communications through a firewall 

For a VibroSight-based machinery monitoring and protection system using a firewall, that is, where 

Windows Firewall is turned on: 

 VibroSight Server now requires that the TCP 55000 port number is configured to be allowed 

through the firewall (that is, added to the exceptions list in Windows Firewall) in order to permit 

communication with VibroSight clients such as VibroSight Vision and VibroSight Mimic. 

(Previously, VibroSight Server could require that multiple TCP port numbers starting at TCP 55000 

were configured to be allowed through the firewall as when an individual VibroSight Server started, it 

took the next available TCP port number starting at 55000.) 

 

 

 VibroSight Configurator 

2.5 Configuring integrated data management 

The VibroSight software has been improved to include integrated support for data management that 

simplifies the configuration and operation of a data management strategy for a VibroSight-based 

machinery monitoring and protection system. 

VibroSight Configurator is used to configure the integrated data management operations that are 

required to be run on the VibroSight data repository used by the system. 

That is, the Offline data storage, Data purge and Database backup operations. 

To configure VibroSight’s integrated data management: 

1. In VibroSight Configurator, in a VibroSight Server configuration, in the Data storage view (left), 

under VibroSight Server configuration, right click on the Data management node level and click 

New Offline data storage, New Data purge or New Database backup to add the required data 

management operation. 
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2. To configure an Offline data storage operation, in the Data storage view (left), select the Offline 

data storage node level and configure the parameters in the main working area (centre), as follows. 

 

On the General tab: 

In the Name field, enter a name for the Database backup operation (or use the default name). 

In the State field, the operation is enabled by default. The state can be changed to Disabled if the 

VibroSight Server is required to ignore the operation. 

Under Data span, use the Total data span controls to configure the maximum combined size for all of 

the offline data files (data repositories). For example, 3 years worth of data ( 3 year(s) ) or 100 GB 

worth of data ( 100 gigybyte(s) ). 

NOTE: The Total data span can be specified either: 

• In terms of time ( year(s), month(s), week(s), day(s) or hours(s) ). 

• In terms of storage device space ( gigabyte(s) or megabyte(s) ). 

Under Data span, use the Data file time span controls to configure the maximum size of each 

individual offline data file (data repository) in terms of time range. For example, 1 months worth of data 

( 1 month(s) ). 

NOTE: If both the Total data span and Data file time span controls are configured in 

terms of time, VibroSight uses the values of the Total data span and Data file 

time span controls to calculate the number of individual offline data files (data 

repositories) that are required and updates the data file numbering (“Data file n”) in 

the user interface accordingly.  

Together, the individual Data files (offline data repositories) act as a “rolling buffer” 

that is continually being rewritten in order to always have the most recent data for 

the Total data span available. That is, once the number “n” of individual Data files 

required to cover the Total data span is reached, each time a new individual Data 
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file with the latest data becomes available, the oldest individual Data file with the 

oldest data is automatically deleted. 

Using a “rolling buffer” to limit the number of individual Data files (offline data 

repositories) ensures that the latest data covering the Total data span is always 

available, while avoiding potential issues such as a disk-full situation. 

 

Under Output file settings, use Storage folder to specify a location for the offline data files (offline 

data repositories), the Auto option can be selected to use the default \Offline data storage 

subfolder; use Filename to specify the file names for the offline data files (offline data repositories), 

the Auto option can be selected to use the default <Database name>_<yyyyMMddHHmmss>.vshda 

file name. 

NOTE: The default <Database name>_<yyyyMMddHHmmss>.vshda file name includes 

a timestamp (date-time string) placeholder that is automatically replaced in the 

created file name by the timestamp derived from the local computer clock at the 

time when the file is created. 

The timestamp placeholder is in the format <yyyyMMddHHmmss>, where yyyy is 

the year, MM is the month, dd is the day, HH is the hour, mm is the minute and ss is 

the second. 

 

Under Output file settings, the Use 2-byte format for dynamic data option can be selected to 

reduce the size of the offline data files (offline data repositories). 

NOTE: This data reduction option affects dynamic measurement data (such as waveforms, 

spectra and orbits) only. 

More specifically, for all of the dynamic measurement data selected to be copied, 

using 2 bytes for each measurement point (rather than VibroSight’s native 4 bytes) 

reduces the offline data files (offline data repositories), at the expense of the 

dynamic range of the measurement data. 

 

Under Output file settings, the Compress output files option can be selected to compress the 

offline data files (offline data repositories). 

NOTE: If the Compress output files option is selected, VibroSight uses its integrated 

compression / file archiving to reduce the size of the offline data files (offline data 

repositories). 

If the Custom compression command option is also selected, VibroSight uses 

the specified external third-party compression / file archiving software tool and 

options to reduce the size of the offline data files (offline data repositories). For 

example, compression / file archiving software such as 7-Zip or WinRAR. 

 

Under Output file settings, use Create log report file to generate a log report file and Create 

summary file to generate a summary file for the Offline data storage operation. 
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NOTE: The log report file for an integrated data management operation contains technical 

information concerning the options used and the progress of the operation. 

The summary file for an integrated data management operation contains a 

summary of the data processed by and included in the files created by the 

operation. 

 

On the Data selection tab: 

Select the type of measurement data to copy based on the data type: Variables, Spectra, Orbits, 

Waveforms and/or Alarms/events. In addition, select the actual measurement data to copy using 

either For entire configuration or For selected items. 

If the For selected items control is used, the actual measurements to copy are selected using the 

hierarchical tree structure displayed (Hardware view or Machinery view). 

NOTE: The list of actual measurements available to be copied is displayed as a 

Hardware view or Machinery view, which is dynamically updated depending on 

the controls selected. 

The Show selected only control can be used in order to selectively filter the 

hierarchical tree structure and display only the measurements selected to be 

copied. 

The search box, indicated by a magnifying glass icon, can be used to selectively 

filter the hierarchical tree structure and display only the measurements containing 

the search term. 

On the Data reduction tab: 

Select Perform data reduction (for variables only) to make the data reduction algorithm controls 

available. The data reduction algorithm can be configured to copy the Minimum value and/or the 

Maximum value and/or the First value for the time period specified using the Copy value(s) every 

controls. 

NOTE: This data reduction option affects static measurement data (such as variables) 

only. 

More specifically, for all of the static measurement data selected to be copied, the 

data reduction algorithm keeps only the selected values from the selected time 

period, which is repeated throughout the overall time range to be copied. 

 

On the Output file flagging tab: 

Either select Do not flag or select Flag output file depending on severity in order to configure the 

severity levels (Severities) to flag in the offline data files (offline data repositories) by selecting Out of 

Range, Normal, Information, Alert and/or Danger. In addition, select the actual measurement data 

for which the severities should be flagged. 

NOTE: These file flagging options will automatically add the “_alarm” suffix to the file name 

of the created offline data files (offline data repositories) if any of the copied data 

has alarms/events at the selected severity level. In practice, this feature helps 

measurement data with severity levels of particular interest to be more found more 

quickly. 
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If the Flag output file depending on severity control is used, the actual measurements to be 

checked for severities are selected using the hierarchical tree structure displayed (Hardware view or 

Machinery view). 

NOTE: The list of actual measurements available to be copied is displayed as a 

Hardware view or Machinery view, which is dynamically updated depending on 

the controls selected. 

The Show selected only control can be used in order to selectively filter the 

hierarchical tree structure and display only the measurements selected to be 

copied. 

The search box, indicated by a magnifying glass icon, can be used to selectively 

filter the hierarchical tree structure and display only the measurements containing 

the search term. 

 

When the VibroSight Server configuration containing the Offline data storage operation is applied to 

a VibroSight Server, the VibroSight Server will automatically calculate, schedule and run the individual 

“Copy” commands required in order to act as a “rolling buffer” of the latest individual Data files (offline 

data repositories) from the VibroSight historical data folder (*.vshdf) used as a data repository by 

the VibroSight Server. 

That is, online VibroSight historical data folder (*.vshdf)  

multiple smaller offline VibroSight historical data archives (*.vshda). 
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3. To configure a Data purge operation, in the Data storage view (left), select the Data purge node 

level and configure the parameters in the main working area (centre), as follows. 

 

In the Name field, enter a name for the Data purge operation (or use the default name). 

In the State field, the operation is enabled by default. The state can be changed to Disabled if the 

VibroSight Server is required to ignore the operation. 

Under Data span, use the Online database time span controls to configure the maximum size of the 

online database (data repository) in terms of time range. For example, 3 years worth of data 

( 3 year(s) ). 

NOTE: The Data span can be specified in terms of time ( year(s), month(s), week(s), 

day(s) or hours(s) ). 

For a Data purge operation, the Data span defines the data to keep. 

It is the data outside of the specified Data span that is purged (that is, data outside 

of the specified Data span is permanently deleted and cannot be recovered!). 

 

Under Output file settings, use Create log report file to generate a log report file and Create 

summary file to generate a summary file for the Data purge operation. 

NOTE: The log report file for an integrated data management operation contains technical 

information concerning the options used and the progress of the operation. 

The summary file for an integrated data management operation contains a 

summary of the data processed by and included in the files created by the 

operation. 
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When the VibroSight Server configuration containing the Data purge operation is applied to a 

VibroSight Server, the VibroSight Server will automatically calculate, schedule and run the individual 

“Purge” commands required in order to limit the maximum size of the online VibroSight historical data 

folder (*.vshdf) used as a data repository by the VibroSight Server. 

That is, online VibroSight historical data folder (*.vshdf)  

made smaller (*.vshdf). 

 

4. To configure a Database backup operation, in the Data storage view (left), select the Database 

backup node level and configure the parameters in the main working area (centre), as follows. 

 

In the Name field, enter a name for the Database backup operation (or use the default name). 

In the State field, the operation is enabled by default. The state can be changed to Disabled if the 

VibroSight Server is required to ignore the operation. 

Under Periodicity, use the Backup periodicity controls to configure how frequently the online 

database (data repository) must be backed up. For example, every day (1 day(s)). 

NOTE: The Backup periodicity can be specified in terms of time ( year(s), month(s), 

week(s) or day(s) ). 

 

Under Periodicity, use the Start backup at control to configure the preferred time for the online 

database (data repository) backup operation to start. 

Under Output settings, use Storage folder to specify a location for the backup files (the Auto option 

can be selected to use the default \Database backup subfolder); Incremental backup is enabled 

by default in order that the individual copy commands used for the backup operation only copy 

data/files that have changed since the last time a copy command for the Database backup operation 
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was run (in order to improve overall system performance); use Create log report file to generate a log 

report file for the Database backup operation. 

NOTE: The log report file for an integrated data management operation contains technical 

information concerning the options used and the progress of the operation. 

 

When the VibroSight Server configuration containing the Database backup operation is applied to a 

VibroSight Server, the VibroSight Server will automatically calculate, schedule and run the individual 

“Copy” commands required in order to create a backup of the online VibroSight historical data folder 

(*.vshdf) used as a data repository by the VibroSight Server. 

That is, online VibroSight historical data folder (*.vshdf)  

offline VibroSight historical data folder (*.vshdf). 

 

When a VibroSight Server configuration containing integrated data management operations 

(Offline data storage, Data purge and/or Database backup) is applied to the configuration running 

on a VibroSight Server, the VibroSight Server automatically calculates, schedules and runs the 

individual commands required to implement the configured data management strategy. 

See also 2.1 Support for integrated data management and 2.7 Running integrated data management. 

 

 

2.6 New consistency checks 

The Consistency checker has been improved to include new checks for the configuration of 

VibroSight’s integrated data management operations (Offline data storage, Data purge and 

Database backup). 

 

 

 VibroSight Server 

2.7 Running integrated data management 

The VibroSight software has been improved to include integrated support for data management that 

simplifies the configuration and operation of a data management strategy for VibroSight-based 

machinery monitoring and protection systems. 

When a VibroSight Server configuration containing integrated data management operations 

(Offline data storage, Data purge and/or Database backup) is applied to the configuration running 

on a VibroSight Server, the VibroSight Server automatically calculates, schedules and runs the 

individual commands required to implement the configured data management strategy (corresponding 

to the operations configured in VibroSight Configurator). 

In addition, the Data management tab of a VibroSight Server displays information about the individual 

commands accessing the server’s data repository in order to make it easier to know the state of the 

data management for the system. 
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The information displayed on the Data management tab consists of individual “Copy” and “Purge” 

commands that correspond to either: 

 Integrated data management operations, that is, the Offline data storage, Data purge and/or 

Database backup operations configured in VibroSight Configurator. 

Note: The individual commands corresponding to integrated data management operations are run 

automatically. 

 Data repositories commands, that is, the Copy, Summary, and/or Purge commands that are run 

from VibroSight System Manager. 

Note: These individual commands corresponding to Data repositories commands are run 

manually. 

See also 2.1 Support for integrated data management and 2.5 Configuring integrated data 

management. 

 

 

2.8 Exiting a VibroSight Server 

When a VibroSight Server is exited (closed) using the Close button (top right) or the File > Quit 

command, the VibroSight Server prompts the user for confirmation before closing. 

(Previously, when a VibroSight Server was exited using the Close button (top right) or the File > Quit 

command, the VibroSight Server closed without prompting the user.) 

 

 

 VibroSight System Manager 

2.9 Data repositories commands 

The Data Repositories commands have been updated to remove the features and options required to 

help automate data management for a system, as the VibroSight software now includes integrated 

support for data management (that is, there is no longer any requirement for a separate task 

scheduler such as Windows Task Scheduler to help automate data management for a system). 

For example, the Save to batch file control used by some Data Repositories commands to help create 

a Windows batch file (*.bat) for use with the command-line equivalent of the command has been 

removed. 

While the Data repositories commands that exist in VibroSight System Manager (Copy, Summary, 

Database update and Purge) will continue to be supported as System Manager commands, the 

command-line equivalent of these commands are no longer supported, as for the purposes of data 

management strategy they are effectively replaced by VibroSight’s integrated data management 

operations. 

NOTE: Starting with VibroSight 3.3.0 the command-line equivalent of the Data repositories 

commands that exist in VibroSight System Manager are no longer supported, that 

is: vibrosightdatacopy.exe (Copy), vibrosightdatapurge.exe (Purge) 

and vibrosightextractsummary.exe (Summary). 
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NOTE: Because of the changes to the VibroSight System Manager Data repositories 

commands, any existing data management and system backup procedures for a 

VibroSight-based machinery monitoring and protection system must be manually 

migrated to use VibroSight’s integrated data management operations in order to 

ensure that the data management continues to work. 

Typically, such VibroSight data management procedures include batch files using 

the vibrosightdatacopy.exe and/or vibrosightdatapurge.exe 

command-line commands that are run by Windows Task Scheduler. 

 

See also 2.1 Support for integrated data management. 

 

 

 VibroSight Vision 

2.10 Displaying frequency data in a Trend plot 

The Trend plot has been updated to include an additional option that supports the plotting of frequency 

(or pressure) data in different ways. The new Trend plot option is called Y-axis frequency format, 

Curve and is applicable to Trend plots that plot frequency data (in addition to amplitude and/or phase 

data). 

NOTE: Frequency measurement data is generated by VM600 XMx16 cards using a 

dynamic processing block and a frequency domain extraction with a Data type 

such as Phasor / Amplitude + Phase + Frequency or 

Frequency line / Amplitude + Frequency. 

 

Depending on the configuration of the Y-axis frequency format, Curve option, frequency (or 

pressure) data is plotted in the following ways: 

 Default – displayed with or without points for each measurement (depending on the Points option 

configured for the plot and the overall plot data density) and with a line connecting each 

measurement. 

Note: By default, VibroSight Vision considers the overall plot data density (that is, the number of 

data entities in the plot) when deciding whether to display points for each measurement. 

 Only points – displayed with points for each measurement (independently of the Points option 

configured for the plot and the overall plot data density) and without a line connecting each 

measurement. 

Note: Displaying frequency (or pressure) data as Only points can provide a “clearer view” of the 

data and any underlying phenomena. 

 Only lines – displayed without points for each measurement (independently of the Points option 

configured for the plot and the overall plot data density) and with a line connecting each 

measurement. 
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 Points and lines – displayed with points for each measurement (independently of the Points 

option configured for the plot and the overall plot data density) and with a line connecting each 

measurement. 

(Previously, the Trend plot only supported the display of frequency data in a single way, equivalent to 

the Default option.) 

 

To configure the plotting of frequency data in an individual Trend plot, the properties of the plot can be 

changed as follows: 

1. Right-click the plot, then click Plot properties, or click the Plot > Plot properties menu command. 

    The Plot properties window for the Trend plot is displayed. 

2. In the Plot properties window, on the General tab, under Layout, select or clear the Points control 

as required, then click Apply or OK. 

3. In the Plot properties window, on the Y-axis tab, on the Frequency (or Pressure) tab, under 

Format, configure the Curve control to Default, Only points, Only lines or Points and lines as 

required, then click Apply or OK. 

The updated settings configured for the individual Trend plot are immediately applied to the plot. 

 

Alternatively, the default plot settings for all Trend plots can be changed as follows: 

1. Click the Tools > Options menu command. 

    The Options window for VibroSight Vision is displayed. 

2. In the Options window, select Default plot settings (left pane), and on the General tab (right 

pane), under Layout, select or clear the Points control as required, then click OK. 

3. In the Options window, select Trend plot (left pane), and under Y-axis frequency format (right 

pane), configure the Curve control to Default, Only points, Only lines or Points and lines as 

required, then click OK. 

The updated default settings configured for all Trend plots are used the next time that a Trend plot is 

created. 

 

 

2.11 Displaying historical data from multiple different time ranges 

It is now possible to display historical data from different time ranges in a single plot in order to make it 

easier to compare and analyse data. 

Displaying historical data from different time ranges is primarily supported by the Custom historical 

mode of the Time Range tool window when using absolute time ranges. 

To display historical data from different time ranges in a plot, select the measurement data and the 

plot type as usual, and specify an initial time range as follows: 

1. In the Time Range tool window, use the drop-down list box at the top of the window to select 

Custom historical and under Time, select Absolute. 
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2. In the Time Range tool window, use the From and To controls to specify an (absolute) time range 

using a start date/time and an end date/time. 

3. In the Time Range tool window, click Apply to apply the specified time range to the VibroSight 

Vision project (session) and its plots. 

   The displayed plots are updated to use the initial time range specified. 

Then specify any additional time ranges as follows: 

4. In the Time Range tool window, under the From and To controls, click the New button to add an 

additional absolute time range time. 

5. In the Time Range tool window, use the additional From and To controls to specify an additional 

time range using a start date/time and an end date/time. 

6. In the Time Range tool window, click Apply to apply the additional specified time range to the 

VibroSight Vision project (session) and its plots. 

   The displayed plots are updated to use the initial and the additional time ranges specified. 

NOTE: When working with multiple different time ranges in the Custom historical mode 

using absolute time ranges, a single individual curve is used by each measurement 

(data entity) across the different time ranges. 

 

When working with multiple different time ranges in the Custom historical mode using absolute time 

ranges: 

 The New button is used to add a new time range. 

 Up to 10 different time ranges can be used at any one time. 

 The Delete buttons are used to remove existing time ranges. 

 At least 1 time range must be active at any one time (that is, it is not possible to delete all of the 

time ranges). 

 When a new time range is added, its From and To controls are initially populated with the values 

from the previous time range but these should be changed. 

 The Back and Forward buttons are used to navigate backwards and forwards through the plotted 

measurement data in time by automatically updating the time ranges to use new time ranges that 

are the same duration as the previous time ranges but are shifted forwards or backwards in time 

(by the duration of the time ranges). 

Note: When using the Back and Forward buttons, changes to the time ranges are automatically 

applied, so there is no need to use the Apply button. 

 

Although displaying historical data from different time ranges is primarily supported by the Custom 

historical mode of the Time Range tool window using absolute time ranges, it is also possible to use 

the Machines states mode or the Alarms mode of the Time Range tool window to specify (absolute) 

time ranges. 
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For example, use the Machines states mode of the Time Range tool window to specify (absolute) 

time ranges, as follows: 

1. In the Time Range tool window, use the drop-down list box at the top of the window to select 

Machine states. 

2. In the machine states grid, select one or more machine states, then right-click on one of the 

selected machine states and click Convert to custom historical. 

The Time Range tool window switches from the Machine states mode to Custom historical mode with 

the Time set to Absolute, and with multiple absolute time ranges specified that correspond to the 

selected machine states (that is, with the From and To controls automatically set to the dates and 

times corresponding to the selected machine states). 

The updated Custom historical time ranges are also automatically applied to the VibroSight Vision 

project (session) and its plots (that is, the displayed plots are updated). 

This example is equally applicable to the Alarms mode of the Time Range tool window, by 

substituting Alarms, and in the alarms grid, selecting one or more alarms. 

 

 

2.12 Improved zooming in plots 

The zoom functionality in VibroSight Vision plots has been improved as follows: 

 Dragging the pointer from left to right or from right to left now results in the same behaviour, that 

is, these actions define the required zoom area and the plot zooms to the region of the plot 

defined by the zoom area. 

 Using the ESC key or the Zoom reset button on the toolbar resets the plot to how it was initially 

displayed, that is, with no zoom. 

(Previously, dragging the pointer from left to right zoomed the plot to the region of the plot defined by 

the zoom area, while dragging the pointer from right to left reset the plot to not use any zoom.) 

Note: The zoom functionality in Polar plots and Polar waveform plots has not changed as they already 

supported dragging the pointer from left to right or from right to left actions in order to define the 

required zoom area. 
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VM600 XMx16 cards 

2.13 XMx16 cards: Relaxed constraints for dynamic data retention time 

VM600 XMx16 card firmware now includes relaxed constraints for dynamic data retention time. 

Some of the XMx16 card's on-board memory is organised as three multi-level circular buffers for the 

temporary storage of dynamic data (waveforms and spectra): the level 1 buffer has an update rate of 

100 ms (note: can be less than 100 ms for big FFTs), the level 2 buffer has an update rate of 1 s, the 

level 3 buffer has an update rate of 10 s. The card memory allocated to each circular buffer is fixed but 

the proportion allocated to each level (100 ms, 1 s and 10 s) is configurable. 

In order to reduce the possibility of missing data due to a VibroSight Server not retrieving data from 

VM600 XMx16 cards before it is overwritten (circular “roling” buffer), memory utilisation by the VM600 

XMx16 cards has been optimised in order to maximise the memory available to the level 1 buffer 

(100 ms data). 

Accordingly, this VM600 XMx16 card firmware update is particularly useful for data intensive 

VibroSight applications, where the VibroSight Server is running on a less powerful computer and may 

not otherwise be able to keep up with all of the 100 ms data available from the card, all of the time. 

NOTE: In order to run VibroSight 3.3.0 for machinery monitoring systems containing 

VM600 XMx16 cards, a firmware upgrade to the latest version of XMx16 card 

firmware is required. See 5.2 VM600 cards. 
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3 Solved problems and bug fixes 

General 

3.1 Improvements and bug fixes 

General stability improvements across the VibroSight 3.3.0 software. 

 

3.2 VibroSight client connections to local and remote VibroSight Servers are 
mutually exclusive 

When a VibroSight Server was running on a (local) computer, a VibroSight client, such as VibroSight 

Configurator or VibroSight Vision running on the same (local) computer could not connect to a 

VibroSight Server running on a different (remote) computer. 

 

3.3 VibroSight Servers listen to a single IP address 

A VibroSight Server used one specific IP address for connections to VibroSight clients and all 

communication was directed through this VibroSight Server IP address. This IP address could be set 

to any of the available network adapters or logical addresses on the host computer running the 

VibroSight Server. On a computer with a single network adapter, the IP address of the single network 

adapter was used by default. 

In typical applications, the network adapter of the host computer running the VibroSight Server is 

connected to a dedicated control (industrial) Ethernet network that contains the VibroSight-compatible 

hardware such as VM600 XMx16 cards and VibroSmart devices. 

However, as a VibroSight Server used one specific IP address (network adapter), this prevented 

concurrent connections from VibroSight clients running on other separate networks, such as a 

business (corporate) Ethernet network. 

 

3.4 VibroSight Server communication errors 

Under rare circumstances, when a computer running VibroSight clients had two network adapters 

(cards) installed, communications errors with a VibroSight Server were possible. 
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4 Known issues 

4.1 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time 

or Local computer time and the site time or local computer time is subsequently changed on the 

relevant computer (for example, using Windows > Control Panel > Date and Time), this change is not 

reflected in the VibroSight Vision user interface until the user clicks on the Timestamp displayed in 

the VibroSight Vision status bar. 

 

4.2 VibroSight Server and Host Service restart required after changes to 
network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or 

disconnected) on a computer running VibroSight, then the VibroSight Servers and Host Services 

running on the computer must be restarted in order for the network adapter to be recognized by the 

VibroSight discovery mechanism. 

 

4.3 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 

27 characters were allowed in previous versions. This constraint is enforced during the creation of new 

server instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 

hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 

VibroSight Server names. 

 

However, existing server instances may be non-compliant (too long) and no longer run after an 

upgrade of the VibroSight software. In such cases, the file names used for the VibroSight Server 

database file (*.vssrvdb or *.db) and the VibroSight Server configuration file (*.vssrvcfg or 

*.config) should be updated (and manually edited in the VibroSight configuration file) to be 

18 characters or less. Changes may also be required in any VibroSight software that references the 

server instance name, such as VibroSight Vision projects. 

Where used, the automated database copies append a timestamp (_yyyyMMddHHmmss) to the 

Server instance name which reduces the number of file name characters that remain available for 

VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 

after the database copy is complete. 

Also, depending on the VibroSight Server database file names used and any truncation performed by 

VibroSight, it is possible that servers are created with names that contain non-allowed characters 

(such as spaces), with the result that these servers will not be accessible by VibroSight software 

clients. Similarly, duplicate VibroSight Server names are also possible. 
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NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 

arising due to truncation and/or additional databases being created during 

automatic data management. 

This is particularly important for systems with automated data management and 

system backup procedures that use script files containing database commands 

(such as copy and backup) that can automatically generate VibroSight Server 

database files. 

 

4.4 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, 

UTC time or Local computer time, all other VibroSight client software modules continue to display 

timestamps in local computer time only (that is, the date and time according to the local clock of the 

computer running the VibroSight software module). 

 

4.5 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always 

update correctly to show all of the devices (VM600 cards and VibroSmart devices) available on the 

network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a 

refresh (using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

 Wait a few minutes and refresh again. 

 Restart VibroSight System Manager. 

 

4.6 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight 

Mimic client software module for mimics (that were previously available in VibroSight Vision). As a 

result, VibroSight Vision mimics created with VibroSight 2.9.7 or earlier are not compatible with 

VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client 

software module. As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are 

not compatible with VibroSight 2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to 

include version information, in order to improve the compatibility between projects created with 

different versions of VibroSight Mimic and eliminate the requirement for the recreation of Mimics. 

Starting with VibroSight 2.11.5, Mimic projects automatically detect any changes in the VibroSight 

Mimic software that affect project compatibility, inform the user and update the project as required. 
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NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 

VibroSight 2.11.0 or later, if the corresponding database had been updated as 

required. 

 

NOTE: When updating existing machinery monitoring projects created with 

VibroSight 2.12.x to VibroSight 3.3.0, a new data repository created by copying a 

VibroSight database (*.vssrvdb) to a VibroSight historical data folder (*.vshdf) 

must use the same server file name as the existing server in order for existing 

VibroSight Mimics to maintain links with the data repository and continue to work 

(without manual corrections). 

In addition, the VibroSight Server using the new data repository must be running 

before the existing VibroSight Mimics are run for the first time, after the update. 

 

4.7 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a 

VibroSight system and the external OPC server becomes unavailable, the VibroSight OPC Client may 

not always recover automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error 

messages even when OPC server is available and can result in permanent loss of the imported data if 

not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 

as expected. 

Any VibroSight system feature or configuration element relying on the imported 

OPC data will not behave as expected, for example, alarms, machinery operating 

conditions and data logging rules. 

 

If this behaviour is seen, the recommended workaround is to: 

 Stop and restart the VibroSight OPC Client from either the VibroSight Server 

(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

 Stop and restart the VibroSight Server, if required. 

 

4.8 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event 

information available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event 

information available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate 

events being listed in the Event Viewer, particularly for VibroSight systems being operated without an 

NTP server (where events are not recognised as duplicates due to time drift). 
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4.9 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server 

are not correctly displayed and updated when an NVIDIA WMI driver is installed on the same 

computer as the VibroSight Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 

management and control technology that interfaces to Microsoft’s Windows 

Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 

processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required 

counter values from the underlying operating system / computer. 

 

4.10 XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing 

Block that is used as an input to a Dual Shaft Relative Processing Block which is configured to provide 

an Orbit and/or Full Spectrum output, then any pre-logging configured for the principal mode 

Waveform and/or Spectrum of Dynamic Input Channel 16 will not actually log any of the data from the 

same pre-logging scope. 

 

4.11 Problems creating new VibroSight OPC Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 

VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight 

OPC Servers. 

Such problems are typically characterised by the OPC Server Create command in VibroSight System 

Manager displaying an error message such as 

“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ 

threw an exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight 

OPC Servers is being used by the later installation of VibroSight, which can happen in one of two 

ways: 

 When a later version of VibroSight 3.x.x is installed on a computer that was running an earlier 

version of VibroSight 2.x.x, the VibroSight installer automatically checks existing VibroSight folders 

(such as C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user 

preference files across to the new VibroSight folders (such as 

C:\ProgramData\Meggitt\VibroSight), including an earlier OpcServer.config file. 

 When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of 

a VibroSight OPC installer using VibroSight 3.0.0 automatically created an earlier 

OpcServer.config file. 
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As shown below, the first few lines of a typical OpcServer.config file contains version specific 

information that is incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems 

are experienced when creating new VibroSight OPC Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the 

version specific information. That is, change the line containing the section name 

from: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 

    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 

    file is used (and not some other version from cache memory). 

 

3. Use the OPC Server Create command in VibroSight System as required. 

 

NOTE: The manual migration of existing VibroSight OPC Servers to VibroSight 3.x.x is 

described in detail in the “VibroSight OPC Server migration” section of the latest 

 Getting started with VibroSight installation guide. 
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check 

to see if the required Microsoft .NET Framework (see section 5.1.2), Microsoft Visual C++ 

Redistributable Package (see section 5.1.3) and OPC Core Components Redistributable 

(see section 5.1.4) are pre-installed. 

The required Microsoft .NET Framework and Microsoft Visual C++ Redistributable Package must be 

manually installed on the computer before VibroSight can be installed. If the required Microsoft .NET 

Framework and Microsoft Visual C++ Redistributable Package are not pre-installed, then the 

VibroSight installer will detect this and exit the installation. 

If not already installed, the required OPC Core Components Redistributable software is automatically 

installed on the computer by the VibroSight installer. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 

VibroSight’s prerequisites and compatibility. 

 

5.1 VibroSight software 

VibroSight 3.3.0 is a minor level release and replaces VibroSight 3.2.0. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data 

migration process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data 

repositories based on the VibroSight historical data repositories (VibroSight historical data folders 

(*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data archives 

(*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers 

that were created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC 

Server migration process for these VibroSight OPC Servers. 

Therefore, it is important to note that: 

 New machinery monitoring projects created with VibroSight 3.x.x will automatically use VibroSight 

historical data repositories. 

 Existing machinery monitoring projects created with versions of VibroSight earlier than 

VibroSight 3.0.0 must be manually migrated from Sybase SQL Anywhere databases to VibroSight 

historical data repositories before they can be used with VibroSight 3.x.x. 

 Existing machinery monitoring projects using VibroSight OPC Servers that were created with 

versions of VibroSight earlier than VibroSight  2.12.7 must manually migrate their VibroSight OPC 

Servers before they can be used with VibroSight 3.x.x. 

It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or 

earlier to VibroSight 3.x.x requires that certain steps must be performed using the existing version 

of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 
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NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.x.x is described in detail in the “Data migration” and “VibroSight OPC 

Server migration” sections of the latest  Getting started with VibroSight 

installation guide. 

 

5.1.1 Microsoft Windows operating systems 

VibroSight 3.x.x is compatible with 32-bit versions and 64-bit versions of Microsoft 
®
 Windows 

®
 

operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 

software for 64-bit Windows and 32-bit software for 32-bit Windows. 

The 64-bit version of VibroSight can be installed on 64-bit Windows computers 

only. The 32-bit version of VibroSight can be installed on 32-bit Windows 

computers only. Only a single version of VibroSight can be installed and exist on a 

computer at any one time 

 

See the appendix of this document for detailed information on VibroSight software and Windows 

operating system compatibility. 

 

5.1.2 Microsoft .NET Framework 

For most Windows operating systems, VibroSight 3.x.x or later requires that the Microsoft .NET 

Framework 4.6 or later is installed. 

NOTE: VibroSight 3.x.x requires Microsoft .NET Framework 4.6. 

 

If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect 

this and exit the installation. 

See the appendix of this document for detailed information on VibroSight software’s Microsoft .NET 

Framework requirements. 

 

5.1.3 Microsoft Visual C++ Redistributable Package 

VibroSight 3.x.x requires that the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 

is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 

computers. 
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If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight 

installer will detect this and exit the installation. 

 

5.1.4 OPC Core Components Redistributable 

VibroSight 3.x.x requires that the OPC Core Components Redistributable is installed, in order to 

configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable 

must be installed on OPC client computers in order to allow connections to remote OPC servers and it 

must be installed on OPC server computers in order to allow OPC clients to browse for running OPC 

servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 

computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer 

will detect this and automatically install it as part of the VibroSight software installation. 

 

5.1.5 Sybase SQL Anywhere 11 software 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data 

folders (*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data 

archives (*.vshda) for operation with historical data) are exclusively used for the required data 

repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a 

data repository. Accordingly, the Sybase SQL Anywhere 11 database software is no longer included 

and distributed as part of the VibroSight software. 

NOTE: VibroSight 3.x.x exclusively uses data repositories based on the VibroSight 

historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 

databases and introduced initial support for working with data repositories based 

on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 

SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.x.x is described in detail in the “Data migration” section of the latest 

 Getting started with VibroSight installation guide. 
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5.1.6 VM600 CMS software 

The VM600 CMS software from Meggitt Sensing Systems uses Sybase SQL Anywhere 8. Both 

Sybase SQL Anywhere 8 (VM600 CMS) and Sybase SQL Anywhere 11 (VibroSight) can be installed 

on the same computer. 

However, while SQL Anywhere 8 and SQL Anywhere 11 can be installed on the same computer and 

run at the same time for standard database operations, certain administrative tasks are mutually 

exclusive and may block one another. 

More specifically, all operations that refer to Sybase SQL (a command-line Interactive SQL utility) in 

the background could be directed to the wrong version of Sybase SQL Anywhere. For example, this 

impacts all user operations and system operations involving the creation, copying and updating of 

databases. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have VM600 CMS software installed. 

 

5.1.7 SIMATIC Step 7 software 

The SIMATIC Step 7 software from Siemens typically uses Sybase SQL Anywhere 9. Both Sybase 

SQL Anywhere 9 (SIMATIC Step 7) and Sybase SQL Anywhere 11 (VibroSight) can be installed on 

the same computer. 

However, while SQL Anywhere 9 and SQL Anywhere 11 can be installed on the same computer, they 

cannot run at the same time. 

More specifically, if SIMATIC Step 7 and VibroSight are both installed, certain administrative tasks, 

such as all user operations and system operations involving the creation, copying and updating of 

databases, may not work correctly. If this behaviour is seen, the recommended workaround is to 

manually change or remove the SQLANY environmental variable in order to allow VibroSight to work 

correctly. 

Note: The SQLANY environment variable is used to contain the directory where Sybase SQL 

Anywhere is installed. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have SIMATIC Step 7 software installed. 

 

5.1.8 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience 

problems running the VibroSight software, characterised by the VibroSight software not running or 

running incorrectly. This is because the Dell Backup and Recovery software can use a version of 

SQLite and associated libraries (DLLs) that prevent the VibroSight Host Service from running 

correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect 

to data sources and/or VibroSight System manager may not display all of the commands expected to 

be available in the Actions window. 
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If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery 

software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have Dell Backup and Recovery software installed. 

 

5.1.9 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same 

computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in 

problems related to credentials (access rights). These problems are typically characterised by an 

unhandled exception in VibroSight Configurator when trying to configure an OPC device in the 

Hardware view or an unhandled exception in a VibroSight Server when trying to handle/process OPC 

data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the 

following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 

Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 

or later). Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x. 
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5.2 VM600 cards 

5.2.1 Firmware 

There are firmware updates for some VM600 cards corresponding to VibroSight 3.3.0. 

The latest firmware for the CPUR remains: 

 Base System: base-system-640-014-001-001.tgz 

 Applications:  applications-640-015-001-001.tgz. 

Therefore, for current versions of the VM600 CPUR card, a firmware upgrade is not required. 

The latest firmware for the XMC16, XMV16 and XMVS16 is now: 

 Base System: base-system-640-003-001-016.tgz 

 Applications:  applications-640-010-001-016.tgz. 

Improvements to this latest VM600 XMx16 card firmware includes relaxed constraints for dynamic 

data retention time, that is, optimised memory to reduce the possibility of missing data in data 

intensive VibroSight applications running on less powerful computers (see 2.13 XMx16 cards: Relaxed 

constraints for dynamic data retention time). 

NOTE: In order to run VibroSight 3.3.0 for machinery monitoring systems containing 

VM600 XMx16 cards, a firmware upgrade to the latest version of XMx16 card 

firmware is required. 

 

 

5.3 VibroSmart devices 

5.3.1 Firmware 

There are no firmware updates for VibroSmart modules and devices corresponding to 

VibroSight 3.3.0. 

The latest firmware for the VSI010 module remains: 

 642-002-000-009.xmsifw. 

The latest firmware for the VSN010 device remains: 

 642-004-000-011.redboxfw. 

The latest firmware for the VSV300 module remains: 

 642-001-000-014.xtranfw. 

Therefore, for current versions of VibroSmart modules and devices, firmware upgrades are not 

required. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. 

Perform the steps in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 

hardware (XMx16 cards and VibroSmart modules and devices) before starting a 

VibroSight system upgrade, in order to establish if any firmware updates are also 

required. 

See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. See 6.2.3 Updating the 

firmware using VibroSight System Manager. 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer 

running VibroSight to keep track of user-configurable settings, so that these settings are remembered 

and applied for the VibroSight installation. 

These settings files have an .xmssettings file name extension and on a computer running 

Windows 7, can be found here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows 

account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default 

settings for VibroSight Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 

• For a computer on which VibroSight was previously installed, an update, upgrade 

or a re-installation of VibroSight will continue to use the previous defaults recorded 

in the .xmssettings files. 

• For a computer on which VibroSight was not previously installed, the installation 

of VibroSight will generate and use new .xmssettings files, which use the latest 

VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 

settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (XMx16) and 

VibroSmart devices (VSI010, VSN010 and VSV300) to be updated to the latest firmware, in order to 

take advantage of improvements to the VibroSight software. 

Updating the firmware VM600 cards or VibroSmart devices is a special task that can, if used 

unintentionally or incorrectly, lead to malfunctioning of the device and affect proper function of data 

acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal 

machinery monitoring functions because its outputs (alarms and relays) can go to undetermined 

states, irrespective of how they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware 

update and the restart (reboot) that is triggered automatically after the firmware update (which can 

take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 

with the operating procedures for the machinery being monitored and that 

appropriate precautions are taken at the control system level (such as DCS 

or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 

order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their 

.tgz file name extension. For example, the XMV16 subfolder contains the applications and base 

system firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt 

Sensing Systems should also be stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that 

is, CPUR card firmware). 

Table 2 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that 

is, XMC16, XMV16 and XMVS16 card firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 

card firmware and VM600 XMx16 card firmware that is compatible with the version 

of VibroSight software being used. 
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Table 1: VibroSight software and VM600 CPUR card firmware compatibility 

 VM600 CPUR firmware. See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-014-001-001 

Applications (*.tgz) 

640-015-001-001 

2.12.7 

609-004-000-036 
 

See note 2
 

3.0.0 

609-004-000-037 
 

3.1.0 

609-004-000-038 
 

3.2.0 

609-004-000-039 
 

3.3.0 

609-004-000-040 
 

 

Notes for Table 1 

1. VM600 CPUR card firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 

640-014-001-xxx for the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-

xxx denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog 

box displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using 

PNRs such as 640-014-000-xxx for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual 

unpacked firmware that is running on the card. 

 

2. This is the first official release of VM600 CPUR card firmware and includes features such as the management of XMx16 card 

configurations for applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus 

interfaces. A firmware upgrade is required in order to run VibroSight 2.12.7 or later. 
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Table 2: VibroSight software and VM600 XMx16 card firmware compatibility 

 VM600 XMx16 firmware. See note 1 

VibroSight 

software 

version 

CD part number 

Base-system (*.tgz) 

640-003- 

001-011 

640-003- 

001-012 

640-003- 

001-013 

640-003- 

001-014 

640-003- 

001-016 

Applications (*.tgz) 

640-010- 

001-010 

640-010- 

001-011 

640-010- 

001-012 

640-010- 

001-013 

640-010- 

001-014 

640-010- 

001-016 

2.12.0 

609-004-000-027 
 

See note 2
 

     

2.12.1 

609-004-000-028 
  

See note 3
 

    

2.12.2 

609-004-000-029 
  

    

2.12.3 

609-004-000-030 
  

    

2.12.4 

609-004-000-032 
  

    

2.12.5 

609-004-000-033 
   

See note 4
 

   

2.12.6 

609-004-000-034 
   

   

2.12.7 

609-004-000-036 
    

See note 5
  

 

3.0.0 

609-004-000-037 
     

See note 6
  

3.1.0 

609-004-000-038 
      

3.2.0 

609-004-000-039 
      

3.3.0 

609-004-000-040 
      

See note 7
 

 

Notes for Table 2 (see the next page)  
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Notes for Table 2 

1. VM600 XMx16 card firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 

640-003-001-xxx for the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-

xxx denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog 

box displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using 

PNRs such as 640-010-000-xxx for the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual 

unpacked firmware that is running on the card. 

 

2. This version of VM600 XMx16 card firmware introduces support for hydro air-gap monitoring. 

 

3. This version of VM600 XMx16 card firmware introduces support for 1 s time-boxed peak-hold processing (that is, spectral 

data aggregation). 

 

4. This version of VM600 XMx16 card firmware implements improved multi-rate digital resamplers (sample rate converters). 

A firmware upgrade is recommended but not required in order to run VibroSight 2.12.5 or 2.12.6. 

 

5. This version of VM600 XMx16 card firmware improves support for faster live data: 100 ms card update rate and up to 100 ms 

VibroSight Vision refresh rate. It also allows a VM600 XMx16 card to be managed by a VM600 CPUR card (“rack controller”), 

eliminating the XMx16 card’s requirement for a VibroSight Server. A firmware upgrade is required in order to run 

VibroSight 2.12.7. 

 

6. This version of VM600 XMx16 card firmware adds support for customer-specific functionality that is enabled by a customer-

specific VibroSight software licence. A firmware upgrade is required in order to run VibroSight 3.0.0 or later. 

 

7. This version of VM600 XMx16 card firmware includes relaxed constraints for dynamic data retention time, that is, optimised 

memory to reduce the possibility of missing data in data intensive VibroSight applications running on less powerful computers. A 

firmware upgrade is required in order to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by 

their .*fw file name extension. For example, the VSV300 subfolder contains the firmware for use by 

VSV300 modules. Any additional firmware updates received from Meggitt Sensing Systems should 

also be stored in these directories. 

Table 3 shows the compatibility between VibroSight software and the VibroSmart VSI010 module 

firmware. 

Table 4 shows the compatibility between VibroSight software and the VibroSmart VSN010 device 

firmware. 

Table 5 shows the compatibility between VibroSight software and the VibroSmart VSV300 module 

firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 

firmware that is compatible with the version of VibroSight software being used. 
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Table 3: VibroSight software and VibroSmart VSI010 module firmware compatibility 

 VSI010 firmware (*.xmsifw). See note 1 

VibroSight 

software version 

CD part number 

642-002 

-000-006 

642-002- 

000-007 

642-002- 

000-008 

642-002- 

000-009 

2.12.0 

609-004-000-027 


 See note 2
 

   

2.12.1 

609-004-000-028 
 

 See note 2
 

  

2.12.2 

609-004-000-029 
  

  

2.12.3 

609-004-000-030 
  

 See note 2
 

 

2.12.4 

609-004-000-032 
   

 

2.12.5 

609-004-000-033 
   

 

2.12.6 

609-004-000-034 
   

 See note 2
 

2.12.7 

609-004-000-036 
    

3.0.0 

609-004-000-037 
    

3.1.0 

609-004-000-038 
    

3.2.0 

609-004-000-039 
    

3.3.0 

609-004-000-040 
    

 

Notes for Table 3 

1. VibroSmart VSI010 module firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-

xxx-000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). 

VibroSight System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-

xxx-000-xxx, which correspond to the actual firmware that is running on the device. 
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2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV300 vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV300 modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 4: VibroSight software and VibroSmart VSN010 device firmware compatibility 

 VSN010 firmware (*.redboxfw). See note 1 

VibroSight 

software 

version 

CD part number 

642-004- 

000-008 

642-004- 

000-009 

642-004- 

000-010 

642-004- 

000-011 

2.12.0 

609-004-000-027 


 See note 2
 

   

2.12.1 

609-004-000-028 
 

 See note 2
 

  

2.12.2 

609-004-000-029 
  

  

2.12.3 

609-004-000-030 
  

 See note 2
 

 

2.12.4 

609-004-000-032 
   

 

2.12.5 

609-004-000-033 
   

 

2.12.6 

609-004-000-034 
   

 See note 2
 

2.12.7 

609-004-000-036 
    

3.0.0 

609-004-000-037 
    

3.1.0 

609-004-000-038 
    

3.2.0 

609-004-000-039 
    

3.3.0 

609-004-000-040 
    

 

Notes for Table 4 

1. VibroSmart VSN010 device firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 

642-xxx-000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). 

VibroSight System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-

xxx-000-xxx, which correspond to the actual firmware that is running on the device. 
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2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV300 vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV300 modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 5: VibroSight software and VibroSmart VSV300 module firmware compatibility 

 VSV300 firmware (*.xtranfw). See note 1 

VibroSight 

software version 

CD part number 

642-001-000-

010 

642-001-

000-011 

642-001-

000-012 

642-001-

000-013 

642-001-

000-014 

2.12.0 

609-004-000-027 


 See note 2
 

    

2.12.1 

609-004-000-028 
 

 See note 2
 

   

2.12.2 

609-004-000-029 
  

   

2.12.3 

609-004-000-030 
  

 See note 2
 

  

2.12.4 

609-004-000-032 
   

  

2.12.5 

609-004-000-033 
   

 See note 2
 

 

2.12.6 

609-004-000-034 
    

 See note 2
 

2.12.7 

609-004-000-036 
     

3.0.0 

609-004-000-037 
     

3.1.0 

609-004-000-038 
     

3.2.0 

609-004-000-039 
     

3.3.0 

609-004-000-040 
     

 

Notes for Table 5 

1. VibroSmart VSV300 device firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-

xxx-000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). 

VibroSight System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-

xxx-000-xxx, which correspond to the actual firmware that is running on the device. 
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2. Updating to this version of VibroSmart VSV300 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV300 vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV300 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade 

the firmware of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to 

incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only 

in systems where the firmware running on the XMx16 cards and VibroSmart devices already 

corresponds to the latest available version that no firmware update is required. Therefore, it is strongly 

recommended to verify the version of firmware running on the hardware before starting a VibroSight 

system upgrade, in order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 

that can – if performed unintentionally – affect the proper functioning of data 

acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 

hardware only when it is necessary. For example, when the devices must be 

updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. 

Alternatively, multiple modules of the same type (for example, VSV3x0) can be updated to the same 

version of firmware at the same time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 

updates to the VibroSight software corresponding to updates to VibroSmart 

modules), VibroSight Configurator should be used to obtain a copy of the 

configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 

command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 

VibroSmart), the File > Open > Device command can be used to read the 

configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 

configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight 

System Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the 

hardware (XMx16 card or VibroSmart module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System 

Explorer window. 
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The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the 

network. If there are no XMx16 cards or VibroSmart devices in the tree structure or some cards 

are missing, verify your network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use 

CTRL+click or SHIFT+click to select multiple devices from the Devices tree-view. (Then, when 

the Change Firmware command is run, all of the devices that were selected will be updated at 

the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the 

device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 

corresponding to the VibroSight-compatible VM600 card or VibroSmart device 

selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 

5 minutes, during which: 

 The IP address beside the device’s serial number in the Devices tree structure can 

disappear. 

 The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 

independently of the VibroSight software (once the process has started), firmware 

updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of 

firmware. It is therefore possible to change a device’s firmware to any previously available version, as 

well as the latest update. 
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This feature can be useful in certain situations, for example, swapping spare VibroSight hardware 

between different VM600 racks or VibroSmart distributed monitoring systems, where systems are 

operating with different versions of VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, the following checks are recommended to ensure that 

VibroSight has not been inadvertently modified and that it continues to operate as expected: 

 Use VibroSight Configurator to run a consistency check on the configuration in order to ensure 

that the configuration has not been modified by any changes to the VibroSight software, 

internal database structure and firmware for the hardware (VM600 cards and VibroSmart 

modules). 

 Use the VibroSight Server window to check that the data acquisition, data post-processing and 

data logging settings are as expected. 

In VibroSight Server, under Device drivers, use the appropriate controls to enable 

communications with the VibroSight-compatible hardware, and under Server features, use 

the appropriate controls to enable the required post processing, for example, data logging. 
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7 Customer support 

7.1 Contacting us 

Meggitt Sensing Systems worldwide customer support network offers a range of support including 

Technical support and Sales and repairs support. For customer support, please contact your local 

Meggitt Sensing Systems representative. Alternatively, contact our main office: 

Customer support 

Meggitt SA 

Route de Moncor 4 

PO Box 1616 

1701 Fribourg 

Switzerland 

 

Telephone: +41 (0) 26 407 11 11 

Email: energysupport@ch.meggitt.com 

Web: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt Sensing Systems technical support team provide both pre-sales and post-sales technical 

support, including: 

 General advice 

 Technical advice 

 Troubleshooting 

 Site visits. 

 

7.3 Sales and repairs support 

Meggitt Sensing Systems sales team provide both pre-sales and post-sales support, including advice 

on: 

 New products 

 Spare parts 

 Repairs. 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensingsystems.com/
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Appendix 
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VibroSight software and Windows operating system compatibility 

 

 

Windows 7 Windows 8.1 Windows 10 

VibroSight software compatible? 

Yes 

(but not recommended for new 

installations as Microsoft support for 

Windows 7 ends in January 2020).  

Yes Yes 

 

 

VibroSight software and Windows Server operating system compatibility 

 

 

Windows Server 2008 R2 Windows Server 2012 Windows Server 2016 

VibroSight software compatible? 

Yes 

(but not recommended for new 

installations as Microsoft support for 

Windows Server 2008 R2 ends in 

January 2020) 

Yes Yes 
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VibroSight software and Microsoft .NET Framework requirements 

VibroSight software version Microsoft. NET Framework requirements 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 

VibroSight 2.9.2 and 2.9.3 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 
See note

 

VibroSight 3.0.0 or later .NET Framework 4.6 

Note: Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended 

solution for most computers (rather than installing Microsoft .NET Framework 2.0). 
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